
 

   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



   

 

 

   

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Legal Notices 
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Quick Start 
 
 
 

Multitrack Recording Steyp-by-Step 
 
このクィックスタート章は、MixPre-10M を箱から取り出して、音楽制作やレコオーダーの設定をはじ
めて行うときの、「ステップバイステップ」、「ハウツー的」な参考書を意味します。 
 
機能に関する詳細な情報、ここで紹介されている手順の詳細については、このユーザーガイドの各章を
参照ください。 
 
 
レコーディングを始めるには： 
 
1. 電源の接続 

少なくとも、バッテリーまたは AC アダプター(付属品)のどちらかで給電します。 
 

2. MixPre-10M の電源を入れる。 
左側面の電源スイッチをスライドして On にすると MixPre が起動します。 
 

3. オーディオ・ソースの接続 
マイクロフォン、ラインか楽器のラインレベル出力などを側面のインプット・ジャックに接続しま
す。 
 

4. ヘッドフォンの接続 
右側面のヘッドフォン・ジャックに、ヘッドフォン・プラグを接続します。 
 

5. 録音用メディアの準備 
Class10 SD カードを背面パネルのスロットに挿入します。 
 
(A)      をタップすると、メイン menu が表示されます。 
 
 
 
 
 
 
 
 
 
 
(B)           （ドット・アイコン）をタップすると、複数ページにアクセスできます。 
 
Info: ドットの数はページ数を表し、ドットにより現在のページ番号を把握できます。 
 
(C) SD Card > Edit > Format とタップします。 
 
(D) OK をタップして、SD カードフォーマットを実行します。 
 
Warning: SDカード内のすべてのデータが消去されます。 
 
(E)       をタップして、ホーム画面に戻ります。 
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6. プロジェクトの作成 
 
(A)       をタップします。 
 
(B) Project > New をタップします。 
 
 
 
 
 
 
 
 
 
(C) 新規プロジェクトの名前を記入するために、Name をタップします。 
 
名前を記入しなければ、MixPre-10M は Song1, Song2 といったユニークネームを自動的に生成
します。 
 
(D) 選択可能なレートから Sample Rate をタップします。 
 
(E) Create をタップします。 
 
 

7. 入力を設定する。 
 
(A) 録音したいトラックに相当するチャンネル・ノブを押します。 例えば、track1 に録音する場
合はノブ 1 を押します。 
 
チャンネル画面が表示されます。 
 
 
 
 
 
 
 
 
 
(B) Input をタップし、HP エンコーダを回してインプット・ソースを選択します。 
選択可能なオプション： Mic, Line, Aux In, USB In 
 
(C) ファンタム電源を必要とするマイクロフォン、DI、その他の機材の場合は、Phantom を選択
します。 
 
(D) Back をタップして、チャンネル画面に戻ります。 
 
(E) トラックへ録音するために、Arm をタップします。 トラックがアームされると、赤色に変わ
ります。 
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(F) ゲイン調整などインプットを聞くために、まず最初にチャンネル・ノブをフェーダー設定が
0dB になるまで回します。 次に Gain（チャンネル画面上）をタップし、HP エンコーダを回して
インプット感度を調整します。 
 
チャンネル・ノブのリング LED はインプット・レベルの大きさに準じて緑色に点灯するので、適
切な信号レベルが入力されている場合は、緑色に点灯する時間が長くなるようにゲインを調整して
ください。入力信号がまだ無い場合は、目安として、マイクソースなら 35dB、ラインソースなら
10dB に調整してください。 
 
Info: ゲイン調整モードは、操作をやめると 5 秒後に終了します。 
 
(G) ドット・アイコンをタップし、設定 2 ページ目を表示させ、Pan, Reverb, Air, など任意の機
能を調整してください。 
 
(H) キーボード、ドラムマシン、コンピュータ出力など、ステレオ音源を接続している場合、Linking
を有効にします。 
 
(I)     をタップしてホーム画面に戻ります。 
 

8. メトロノームの設定 
 
(A)      をタップします。 
 
(B) ページを通して、サブメニューの中の Metronome をタップします。 このサブメニュー表示
中はヘッドフォンでメトロノームのプレビュー音を聴くことができます。 
 
(C) Count-in をタップすると、レコーディング開始前の最初の部分で、メトロノームがどのくら
いカウントするかを設定できます。 
 
(E) メトロノーム設定画面の 2 ページ目にある During… をタップすると、いつメトロノームを
聞くかを設定できます。オプション： Count-in, Record, Play 
 
(F)     をタップすると、メトロノームのプレビュー音が止まります。 
 
(G)     をタップして、Music Control メニューに入ります。 ここで、     をタップするとメト
ロノームが有効になります。 
 
Info:  メトロノームは、MixPre が record, または play に入った時、（During..設定で前もって
選択されているモード）に開始されます。 
 

9. ホーム画面から、録音したいトラック番号が赤く表示されている（Rec アームされて録音準備でき
ている）ことを確認します。 また、メータービューでインプットレベルも確認します。 
 

10. ジョイスティックを REC ポジションに押し、録音、演奏を開始してください。 
 

11. ジョイスティックを STOP ポジションに一度だけ押すと録音停止します。もう一度押すと（2 度押
し）、録音されたデータの最初にロケートします。 
 

12. ジョイスティックを PLAY ポジションに押すと、再生します。再生中にトラックレベル、リバーブ、
エアー、パン、ソロ、ミュートを変更できます。 
Info: エアー効果のあるトラックは一度に 1 トラックだけです。 
 

13. (オプション) 演奏ミスなどでレコーディングをやり直したい場合は、    をタップし、History を
タップします。 HP エンコーダを操作して Restar Song をハイライト状態にします。 
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14. 他のトラックにも別の楽器演奏を録音するには、手順 7 に戻って同じ操作を繰り返します。 
 

15. すべてのトラックに収録が終わったら、曲を再生しながらトラックミックスレベル、パン、リバー
ブ、エアーを調整します。 
 

16. 納得のいくミックスができたら、レンダー機能を用いてあなたのファイルを簡単にシェアできます。 
 
(A)      をタップし、Render をタップします。 
 
(B) レンダーしてファイル化される時のファイル・フォーマットを選択します。 
オプション： Wav stereo,  AAC stereo,  Wav All Isos 
 

17. もっとも大切なことは音楽制作を楽しむことです。 プロジェクトの保存に煩わされることはあり
ません。MixPre はあなたのかわりに煩わしい処理を自動的に行ってくれます。 
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Intro 
 
 
 
MixPre-10M をお買い上げいただきありがとうございます。 我々はオーディオに情熱を持つプロダク
トメーカーです。 我々はデザインとエンジニアチーム（そのほとんどがミュージシャンである）に呼
びかけ、非常にコンパクトで入手しやすいマルチトラックオーディオレコーダーの新しいスタンダー
ドとなるデバイスを作らせました。 
 
このような背景から、サウンドクォリティで録音したいと望むミュージシャン、シンガー、シンガーソ
ングライター用の多用途な機材として我々は MixPre-10M をデザインしました。演奏会、新曲のマルチ
トラック収録、ライブパフォーマンス収録において、MixPre-10M はステージ上で、スタジオで、ある
いは道端で、最高のツールとなります。 
 
この驚愕なキットは、我々の業務用ポータブルレコーダーで培った技術を用いて実現しました。お客様
には、その独特なミックス・パフォーマンス、使いやすさ、そしてこれからの長年に渡ってあなたの
創造性豊かな熱意とあなたのかけがえのない作品を生みだす品質を MixPre-10M に感じ取ってもらえ
れば幸いです。 
 
MixPre-10M は、柔軟性と音質と、３つのベーシックな操作系統を提供すべく細心の工夫により設計さ
れています。 
 
 12-チャンネル・マルチトラックレコーダー、 96kHz/24bit 

 
 超低ノイズ、8 チャンネルマイクプリアンプ 

 
 12-in, 4-out USB コンピュータオーディオインターフェース 
 
MixPre-10M には、ミュージシャンに必須な多くの機能が実装されています。 
 
 トラック・レイヤリング 
 オーバーダビング 
 パンチイン／アウト 
 キューポイント 
 トラック・バウンシング 
 リバーブとヴォーカル・エアーのエフェクト 
 メトロノーム 
 エクスポート 

 
 
MixPre-10M は、Protools, Logic, Cubase, Reaper のような DAW と似たような機能として動作しま
す。しかし、その特化したハードウェアにより、一般的なコンピュータベースのシステムでありがちな
技術的要因で行き詰まることなく、ミュージシャンは楽曲制作に専念することができます。ミュージシ
ャン、ソングライターは簡単操作、高品位な収録用のポータブルツールを使用して、いつでもどこでも
インスピレーションのままに楽曲をマルチレイヤーに収めることができます。 
 
MixPre-10M は、8 つの XLR 入力からのオーディオ・ソースを一度に 8 トラックまで同時に録音するこ
とができます。正しいテンポで演奏できるようにメトロノーム機能、レコーディング時にキャラクター
要素を加えることのできるリバーブとヴォーカルエラー・エフェクト機能が内蔵されており、すばらし
いパフォーマンスを支援してくれます。ヴォーカルエアー・エフェクトは、快活で艶を持たせた親密さ
のあるヴォーカルになる効果を出す EQ とコンプレッションの複合機能で、シンガー／ソングライター
には人気があります。 
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もちろん、MixPre-10M の活用法に際限はありませんが、いくつかの主な機能を挙げると… 
 
 トラックレイヤーとオーバーダビング機能によりマルチレイヤーされた曲を作成できます。 
 小規模なアンサンブルのライブパフォーマンスのミキシングとレコーディング。 
 マルチチャンネルバッキング・トラックの再生。 
 ライブイベント、コンサート、ジャムセッションなどの収録。 
 DAW 用の 12in/4out の高品位 USB オーディオインターフェース 
 
MixPre-10M の電源ソースはさまざまなタイプから選べるので使用用途にさらなる柔軟性を提供します。 
単三型電池、リチウムイオン充電池、壁コンセントからの AC アダプターによる電源供給が可能なので、
いつでも、どこでも、常にあなたがオーディオを取り扱いたい時に MixPre-10M を御利用いただけま
す。 
 
お客様のオーディオ編集作業が MixPre-10M によってより豊かになることを我々は切に願っておりま
す。MixPre-10M を御利用いただいたお客様の御感想をお聞かせいただけると非常にうれしく思います
ので、support@sounddevice.com までご投稿いただけると幸いです。 
 
 

mailto:support@sounddevice.com
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Powering 
 
 
 

Flexible Powering Options 
 
MixPre-10M の設計段階で、我々はさまざまなアプリケーションや使用環境で運用する事ができる製品
であることが非常に重要であると感じました。 これを実現するために、いくつかの電源ソースを選択
していただける仕様となっています。電源ソースを選択する例として以下があります。 
 
 AC パワーサプライ(XL-WPH3)から 4-pin ヒロセコネクターへ 12VDC 給電 
 8 本の単三型アルカリ、または NiMH 充電電池を装着したバッテリースレッド（MX-8AA） 
 1 個か 2 個の Sony タイプ L-mount バッテリーを装着した バッテリースレッド（MX-LMount） 
 

Info: 製品にバッテリーは含まれません。 
 
MixPre-10M の電源スイッチは、左側面の右上に位置しています。 
 
 
 
 
 
 
 
 
 
 
 
 
MixPre-10M に装着されたバッテリー放電を抑えるため、4-pin ヒロセの電源ソースとバッテリーが両
方とも接続されている場合は、ヒロセ電源の優先的に使用されます。 
 
 
バッテリーインジケータで残量を確認するには： 
 
1.      をタップします。 

 
2. リストの中にある、Power をタップします。 

 
 

3. 次のどちらかを操作します。 
 
＞ Battery Sled をタップし、使用しているバッテリータイプを選びます。 
＞ Ext Power をタップし、使用している電源タイプを選びます。 
 
 
 
 
 
 
 
 
 
（表は 688 の資料から引用した資料です。） 
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Panels 
 
 
 

Front Panel 
 
Power ライト、レコーダーのトランスポート用ジョイスティック、スター（＊）トグルスイッチ、チャ
ンネルノブ、チャンネルノブ・リング LED、タッチ画面 
 
 
 
 
 
 
 
 
 
 
 
フロントパネルのチャンネル・ノブは２つの用途があります。 
 LR ミックス用に選択されたトラックのレベルを調整する。 
 ノブを押して、チャンネル画面にアクセスすることができます。 
 
 
 

Left Side Panel 
 
USB 接続、XLR コンボソケット（1/4 インチ TRS）入力、X1/X2 アンバランス出力(3.5mm)、パワ
ースイッチ 
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Right Side Panel 
 
3.5mmヘッドフォン出力ジャック、3.5mm Mic/Aux入力、XLR コンボソケット（1/4インチTRS）、
ヘッドフォン・エンコーダー 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Back Panel 
 
バッテリーマウント、4-pin ヒロセ電源コネクター、SD メモリーカードスロット、六角（アレン）レ
ンチ（1/4 インチ 20 スレッド用）、回転防止固定ピン 
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Screens & Navigation 
 
 
MixPre-10M は、日光下でも見やすい高解像度のタッチパネル内蔵ディスプレイを搭載しています。タ
ッチディスプレイは、Home 画面、Main Menu 画面、Channel 画面から構成されています。  
 
チャンネル画面に関する情報は、後述の Input Channels の章を参照ください。 
 
タッチディスプレイは、直観的に操作できるようにいくつかのタッチ領域があります。にお好みの画
面や機能を割り当ててすばやくアクセスするトグルスイッチ */**もあります。ユーザーインターフェ
ースとして親しみやすいタッチディスプレイの採用により、インプット、アウトプット、レコーディ
ング、メータリングにすばやく直観的にアクセスすることができます。 
 
 
 

Home Screen 
 
Home 画面ビューは、デバイスの電源投入後のタッチスクリーンに表示されるデフォルト・ビューで
す。 この画面には次の情報が表示されます。 
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電源ステータスアイコン アイコン 詳細 

ミュージック・アイコン  Home 画面でこのアイコンにタッチして、Music Control

メニューにアクセスできます。 

現在のネーム  現在のミュージック・プロジェクトの名前が表示されます。 

タイム・カウンター  現在のソング位置を、hh:mm:ss:tenths で表示。すべて

のソングは 00:00:00:0.からスタートします。 Home 画面

でこの部分にタッチして、Music Control メニューにアクセ

スできます。 

Q アイコン  

 

 

現在のキューナンバーを、Q01, Q02.. と表示します。キ

ューポイントを登録すると、簡単にそこへロケートさせる

ことができるので、韻、コーラス、間奏へすばやく飛ぶこ

とができます。 

 

停止中に Q アイコンをタップして、Q-Points メニューを開

くと Q リストやオプションにアクセスできます。 

 

録音・再生中にタップすると、新しいキューポイントを追

加できます。メニュー画面キューポイントは、Play In, 

Record In, Record Out, Stop に利用できます。 

  

 

EXT 緑色 

ヒロセコネクターに接続された外部電源ソースは良好。 

  

 

(Batt) 緑色 

良好なバッテリー。 ゲージが 1/4 まで落ちたらバッテリー

交換を推奨。 

  

 

（赤点滅） 

バッテリー残量がありません。すぐにバッテリー交換を推

奨。 

Menu アイコン  
 

Menu 画面にアクセスするためにタップします。 

Meter ビュー  
 
 

12 トラックとステレオ mix 用のメーター表示。 メーター

を囲む白いボックス枠は、どのトラックがチャンネルノブ

によってコントロールされているかを示します。 

 

水平 L (Left)メーターにタップして、Record サブメニュー

を開き、L&R ゲイン調整にすばやくアクセスできます。 

 

タッチによるトラック・バンクの切替 

 ノブ 5-8 で track5-8 をコントロールするために、セン

ターの垂直メーター部分にタッチします。 

 ノブ 5-8 で track9-12 をコントロールするために、右

の垂直メーター部分にタッチします。 

ノブ 1-4 は常に track1-4 をコントロールします。 

 

ステータス・バー  
 
 

タッチによりステータス情報がサイクル表示されます。 

 Song ステータス：現在のバー位置、パンチとメトロ

ノーム、レンダリングステータス、SD カードの残時

間( idle か recording 時) 

 USB ドライブ残時間 & copy ステータス 

 日付と時刻 
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Main Menu Screen 
 
Menu 画面は、ほとんどの機能、選択された機能、セットアップがあります。 
 
Menu 画面に入るには： 
 
 Home 画面で      をタップします。 
 
３つの Menu 画面ビューがあります。 これらのビューは、ドットアイコン            によって表示
されます。 これをタップして、３つの Menu 画面ビューを切替えることができます。 
 
 
 
 
 
 
 
 
 
 
 
Menu 内のそれぞれのオプションをタップすると、サブメニューが表示されます。 
 

ページ サブメニュー 詳細 

1 Presets SD カードと内部メモリーへ、ユーザー設定のセーブとリコール。 ファクトリー

デフォルトによる全設定のリセット。 

1 Project 新規作成、既存プロジェクトのオープンと削除。 

1 Inputs 3.5mm Aux/Mic 入力用の設定。 

1 Outpus  main L/R と X1/X2 ステレオ出力用のルーティングとゲイン設定。 

2 Reverb リバーブの設定。 

2 Metronome メトロノームの設定。 

2 Record LR ミックスゲイン、ACC エクスポート品質の設定。 

2 SD Card 挿入されている SD カードの情報、フォーマット、カードを空にする機能。 

3 USB Drive USB サムドライブの情報の表示、ドライブのフォーマット。 

3 *Shortcuts さまざまなファンクションをフロントパネルの＊／＊＊トグルスイッチに割り

当て。 

3 System ファイル転送、トーン信号、リミッター、日付、LCD/LED 輝度、ファームウェ

アアップデート、現在のバージョン。 

3 Power 使用しているバッテリーか電源ソースの種類の設定。ここの設定で、Home 画面

のパワーステータスアイコンでバッテリー残量が正しく表示されます。 
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サブメニューからメイン Menu へ戻るには： 
 
       をタップします。 
 
 
メイン Menu から Home 画面に直接戻るには： 
 
    をタップします。 
 
 
 

Music Control Menu 
 
Music Control メニューから Q-List、Solo/Mute 画面、メトロノーム、プロジェクトレンダー、プロジ
ェクトヒストリー、にアクセスできます。 
 
詳細な情報については、後述の各章を参照ください。 
 
Music Control メニューにアクセスするには： 
 
 Home 画面の左上にある     をタップしてください。 
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Using Star ショートカット (*/**) 
 
フロントパネルにあるトグルスイッチは、ユーザーがプログラムできる便利なスイッチです。特化した
ハードウェア・ショートカット */** によく使用する機能を割り当てれば、画面の menu リストから
ナビゲートすることなく、すばやくアクセスできるようになります。 
 
 
スタートグルスイッチに機能を割り当てるには： 
 
1.    をタップします。 

 
2. ＊Shortcuts > *Shortcut (か**Shortcut) を選択します。 

 
表示された＊Menu 画面で、任意の機能を割り当てます。 
 

サブメニュー 詳細 

Solo/Mute screen Solo/Mute サブメニュー画面の表示 

Project プロジェクト・サブメニュー画面の表示 

SD Card SD カード・サブメニュー画面の表示 

Tone トーン信号の On / Off 

Metronome メトロノームの On / Off 

Q キューポイントの設定 

 
 
ショートカット * か ** をアクティブにするには： 
 
 スイッチを * か ** にスライドします。 
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Input Channels 
 
 
インプットチャンネルは、録音されたり他のチャンネルとミックスされたりする前にオーディオ・ソー
スが処理されるパスです。MixPre-10M では、DAW の中の「トラック」と同じと思っていただいてか
ましません。各インプットチャンネルに送られるソースは、8 つの XLR の mic/line、3.5mm Aux 
mic/line、コンピュータからの USB チャンネル 1-4 から自由に選択できます。 
 
MixPre-10M のミキサー出力、内蔵マイク、メトロノームのクリック音も選択することができます。 オ
ーバーダブ機能により、MixPre-10M の録音可能なトラック数は 12 トラックまでで、一度に録音でき
る最大トラック数は 8 トラックまでです。 
 
すべてのインプットチャンネルの設定は、各チャンネル画面の中で調整することができます。 
 
 

Setting the Mode 
 
チャンネル画面にアクセスするには： 
 
 アクセスしたいチャンネルのチャンネル・ノブを押します。 
 
 
 
 
 
 
 
 
 
 
各チャンネル画面には２つの設定用ページがあります。ページ位置はドット・アイコンで示され、ドッ
ト・アイコンにタッチしてページを切替えることができます。 
 

サブメニュー 情報先 

 Solo & Mute Using Solo/Mute 

 Arm Arming a Track 

 Input Setting Input Source 

Monitor Enabling Monitoring 

 Gain Setting the Gain 

 Pan Understanding Pan 

 Reverb & Air Using Reverb & Rendering a Vocal Air Effect 

 Low Cut Setting the Low Cut Filter 

 Phase Toggling Phase Inversion 

 Linking Stereo Track Linking 

 
MixPre-10M は、８つのフィジカルチャンネル・ノブよりも多くのトラック（最大 12）を持つため、track9
以降の設定にアクセスするためには、Bank selector を使用します。 後述 Track Bank Selector を参
照ください。 
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Track Names 
 
各トラックネームは、関連するチャンネル画面から編集することができます。例えば、デフォルトネー
ムの Track1 を Drums に、Track2 を Keybord に、 Track3 を Lead Vocal に、というように。 
 
Track1 の名前を編集するには： 
 
1. チャンネル１のノブを押します。 

 
2. チャンネル画面の左上あたりをタップします。 

 
3. Track1 の新しい名前を入力して、OK をタップします。 

 
編集されたネームは、そのトラックのチャンネル画面のトップに表示され、現在録音されているフ
ァイルのメタデータだけでなく、Render > Wav All ISOs を使用する時のレンダーされた ISO フ
ァイルにもエンベデッドされます。 

 
 

Setting Input Source 
 
Input ボタンで、そのトラックへオーディオ入力ソースを選択できます。 
 
入力ソースとチャンネルの組み合わせは自由に設定できるので、オーディオ・ソースを異なるトラック
に録音したい時にケーブルを差し替える必要はありません。入力ソースに、MixPre-10M の出力
（Bouncing 章を参照）、メトロノームのクリック音（Metronome 章を参照）をアサインすることもで
きます。また、この画面からファンタム電源の On/Off も設定できます。 
 
インプットへルーティングするには： 
 
1. チャンネル画面に入り、Input をタップします。次のサンプル画像のようなルーティング画面が表

示されます。 
 
 
 
 
 
 
 
 
 
 

2. トラックのソースを１つ、選択します。トラックにはライブ入力ソースを１つだけ設定できます。 
 

3. 必要に応じてファンタム電源を有効にします。[Phantom] は 48V 電圧の on/off です。もしコ
ンデンサーマイクロフォンが接続されていれば、ファンタムをオンにしてください。 

 
Info: Phantom オプションは選択されたオーディオ・ソースによっては表示されません。 

 
4. メトロノームのクリック音を録音したい場合は、[Click] を有効にします。録音後のデータを DAW

にインポートして曲にオーバーダビングする場合に便利です。録音されたメトロノームを利用して
DAW のテンポを設定することで、MixPre レコーディングと完璧にそろえることができます。 
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Tip: 曲のアイディアをラフスクラッチとしてすばやく録音したい時にマイクロフォンが手
元に無くて、音質を気にしないのであれば、MixPre 内蔵マイクを利用できます。 Inputs 
> Aux In Mode で Internal Mic に設定し、ルーティング画面で Aux In に設定してく
ださい。サンプル画像の Track4 ではインプットソースとして Internal Mic がアサイン
されています。（他のサンプル画像で、Aux In が Internal Mic となっていない理由は、
Aux In Mode の設定が異なるためです。） 

 
 

Enabling Monitoring 
 
モニター機能は、再生中にライブ・インプット信号も聞くことができます。すでに録音されたトラック
と一緒に練習演奏したり、ライブパフォーマンスに利用したりと便利です。 
 
モニターを有効にするには： 
 
 チャンネル画面に入り、Monitor をタップします。 モニターOn のときボタンはオレンジ色で表示

されます。 
 
 
 
 
 
 
 
 
 
 
 

Setting the Gain 
 
チャンネル用に、トリム・ゲイン（プリフェーダーゲイン）を調整できます。 このゲインはチャンネ
ルの個々のトラックの信号レベルを決定します。例えば、ISO トラックレベル。 
 
ゲインレンジは、選択されたインプット・タイプにより異なります。 
 

・Mic : 6dB ～ 76dB 
・Line : -20dB ～ 30dB 
・Aux Mic : 10dB ～ 40dB 
・Aux Line : -10dB ～ 20dB 
・Aux InMic : 10dB ～ 50dB 
・USB : -20dB ～ 30dB 
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Using Solo/Mute 
 
MixPre-10M には、トラックのミュート、ソロをするためにいくつかの異なる方法があります。 
 
 各トラックのチャンネル画面で、Mute をタップして選択されたトラックをミュートできます。 ミ

ュートされたトラックの信号はミックスと出力に送られません。ミュートされると、ノブ周囲にあ
る LED リングが赤く点灯します。同時に複数のトラックをミュートにすることができます。 
 

 各トラックのチャンネル画面で、Solo をタップして選択されたトラック（プリフェード、プリエ
フェクト）の音をヘッドフォンでモニターできます。ソロになっているトラックは、LED リングが
オレンジに点灯します。 

 
複数のトラックをすばやくソロ／ミュートするには、Solo/Mute 画面が便利です。全 12 トラックのソ
ロとミュートをこの画面から操作、確認することができます。 
 

Info: */** スイッチにアサインしても Solo/Mute 画面にアクセスできます。 
 
 
Solo/Mute 画面からソロまたはミュートするには： 
 

1.     をタップします。 Music Control 画面が表示されます。 
 

2. Solo/Mute をタップします。 Solo/Mute 画面が表示されます。 
 
 
 
 
 
 
 
 
 
 

3. 次のいずれかの操作を行います。 
 

 Solo か Mute のどちらかをタップし、任意のトラックを選択します。ソロになったチャンネル
はオレンジ色で、ミュートされたトラックは赤色で表示されます。 
 

 HP エンコーダを操作して任意のトラックをハイライト状態（緑色の枠）にしてから、Solo か
Mute をタップします。 

 
4.    をタップして、画面を終了します。 

 
 

Arming a Track 
 
Home 画面のメータービューのトラック番号で、アーム（録音有効）されたトラックは赤色で表示され
ます。 
 
トラックを アーム／アーム解除 するには： 
 
 チャンネル画面から Arm をタップして、トラックの Rec アームの On/Off を設定してください。 
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Understanding Pan 
 
Pan 操作で、LR ステレオミックスに対してのトラックのオーディオの L と R の位置が決まります。 
 
Pan レンジは、L16(L 最大)から C（センター）から R16(R 最大) の 33 ポジションです。 
 
 

Using Reverb 
 
リバーブは、LR ミックスの中のトラックにどれだけリバーブ効果を与えるかを設定します。 ミックス
だけに効果があり、個々の録音されたトラックに効果はありません。 
 
個々の録音されたトラックへリバーブ効果をレンダーするには、バウンス機能を利用してください。 
 
リバーブを調整するには： 
 
 チャンネル画面から、Reverb をタップしてエンコーダで調整してください。 調整範囲は、Off, 

-50dB から 0dB まで 1dB ステップです。 
 
タイプ、ディケイ、プリディレイなどの異なるリバーブ・キャラクターを選択できます。 
 
リバーブを設定するには： 
 

1.     をタップします。 
 

2. サブメニューにページして、Reverb をタップします。 
 

3. 次の設定をタップして、値を変更してください。 
 

セッティング オプション 

Reverb Type Off, Plate, Hall, Room 

Reverb Decay 0.1 – 5.0 秒 

Reverb Pre-Delay 0 – 40 ms 

Reverb HF Damp Off, 0 - 20 

 
 

Rendering a Vocal Air Effect 
 
リードヴォーカルに Air エフェクトを適用すると、ミックスの中でヴォーカルが引き立ちます。 これに
よりヴォーカルに快活な艶が付加されます。 
 
ヴォーカル・エアは、LR ミックスの中のトラックにどれだけリバーブ効果を与えるかを設定します。 調
整範囲は、Off, 1% ～ 100%です。 ミックスだけに効果があり、個々の録音されたトラックに効果は
ありません。 
 
個々の録音されたトラックへ Air エフェクトをレンダーするには、バウンス機能を利用してください。 
 
 

Info: Air は一度に１つのトラックに適用されます。トラックに Air を適用したいのに、チャン
ネル画面で Air がグレイになって使えない時、すでに適用されている他のトラックの Air
を外してください。複数のヴォーカルトラックに Air を適用するには、バウンス機能を
利用してください。 
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Setting the Low Cut Filter 
 
マイクハンドリングノイズや、ウィンドノイズで発生する不必要な低域成分を減衰するためにローカッ
トを使用してください。 
 
Low Cut ボタンから、On/Off とローカットフィルターを設定できます。範囲は、Off, 40～160Hz の 
40Hz ステップです。 
 
 

Toggling Phase Inversion 
 
 
位相反転（または極性反転）は、間違って配線されたバランスケーブル、反対方向に向いて設置された
２つのマイクロフォン（ドラムキットのオーバーヘッドなど）、などのシグナル・キャンセレーション
を防ぐために用いられます。 
 
Phase 設定は、位相反転の On／Off です。 
 
チャンネルの位相を反転するには： 
 
 チャンネル画面から Phase をタップします。 
 
 
 

Stereo Track Linking 
 
入力ソースがステレオの場合、２つのペア・トラックに組むと１つのノブで両方のペアのレベルをコン
トロールできて便利です。キーボードやステレオ・マイクのようなステレオソースを利用する場合、
MixPre-10M のインプット 1-2, 3-4,などに接続し、ペアとなる最初のチャンネル画面の Linking 
menu でリンクしてください。リンクによって、奇数番号のノブで両方のレベルをコントロールできま
す。 
 
次の例では、チャンネル 1 と 2 をリンクする手順を紹介します。 
 
 
Ch 1,2 をリンクするには： 
 
1. チャンネル画面に入るために Ch-1 のノブを押します。 

 
2. Linking をタップします。 

 
3. ステレオソース用に 1-2 を選択します。 

これでトラック 1 と 2 の両方のレベルを Ch-1 ノブでコントロールできます。 
 
 

Configuring Aux in Mode 
 
Aux/Mic In コネクターの設定をするには： 
 
1.      をタップします。 

 
2. Inputs > Aux In Mode とタップします。 
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3. 次のオプションから１つを選択します。 
 

・Mic Aux/Mic In に Mic 接続されるときのオプションです。 MixPre-10Ｍは
PiP(Plug-in-Power)用のバイアス電圧を供給します。 

・Line Aux/Mic In に、スマートフォンのヘッドフォン出力などのアンバランス 2ch ライ
ンソースが接続されるときのオプションです。 

・Internal Mic 入力ソースとして内蔵マイクを使用するときのオプションです。例えば、曲アイ
ディアをラフ・スクラッチとしてすばやく録音したい場合、マイクロフォンが手
元になくて音質にこだわらないのであれば、フロントパネル（チャンネルノブ 8
の隣）に内蔵されるマイクを利用することができます。 

・Off オフは、Aux/Mic input のオーディオがミュートされます。 
 

Tip: 入力ソースに内蔵マイクを選択するには、まず、Inputs > Aux In Mode で Internal 
Mic に設定します。次に、Channel > Input’s Routing 画面で Aux In を選択してくだ
さい。 

 
 
 

Track Bank Selector 
 
フィジカルノブ（８x Konbs）よりも多くのトラック（12tracks）数があるので、トラック・バンク・
セレクター機能があります。これは、メータービューの中で白い枠線で示され、コントロールしたいト
ラックグループを選択するために用いられます。 
 
次の例では、トラック 1-4 と 9-12 が、フロントパネルにあるチャンネル・ノブでコントロールされる
ことを示しています。 
 
 
 
 
 
 
 
 
 
 

Info: チャンネル・ノブ 1-4 は常にトラック 1-4 をコントロールします。 
 
 
トラック・バンクを切替えるには、つぎのいずれかを操作します： 
 
 下列ノブ(5-8)でトラック 5-8 をコントロールするには、5-8 のメーターをタップします。 
 トラック 9-12 をコントロールするために、9-12 メーターをタップしてノブ 5-8 を切替えます。 
 
トラック・バンクが切替わると、新たに選択されたバンクの中でノブを回したとしても、以前にストア
されたフェーダー値に達しない限り、ノブの位置が実際のレベル調整に反映されません。以前の値に達
すると、ゲイン調整は通常通りにノブの回転位置と連動します。 
 

Info: トラック・バンクが切替えた後、ノブの回転位置がフェーダー値とそろっていないなら、
ノブの LED がオレンジ色で点滅します。ノブ位置とフェーダー値がそろった時点で消灯
します。 
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チャンネル・ノブ調整中のフェーダー値と、以前にストアされているフェーダー値がオレンジ色で
Home 画面（かチャンネル画面）の上部に表示されます。 ノブを調整して両方の値が一致したところ
で、数字の色が黒色に変わります。 
 
フェーダーレベル表示の例： 
 
この例では、フィジカルフェーダーの値が -18dB で、トラック 9 のチャンネル・ノブを時計回転方向
に調整しなければならないことを矢印が示します。以前にストアされている値、ここでは -15dB に達
すると、ミックスレベル調整できるようになります。 
 
 
 
 
 
 

Info: 以前にストアされたフェーダー値と矢印アイコン（オレンジ色）を表示させるためには、
チャンネル・ノブをごくわずか調整してください。情報が表示されることで、どちらの
向きへフェーダーを調整するべきかを判断できます。 
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Outputs 
 
 
 
MixPre-10M は 2 ペアの出力、L/R と X1/X2 を持ちます。 L/R の TA3 出力コネクター（長距離ケーブ
ル接続向け）はバランスで、X1/X2 の 3.5mm ジャックはアンバランスです。 
 
L/R と X1/X2 ステレオ出力へ送るには： 
 
 
1.    をタップします。 

 
2. Outputs をタップします。 

 
3. 次のどちらかを操作します。 
 
 L/R Out をタップして、右側面の L/R 出力へ送る設定をします。 
 X1/X2 Out をタップして、左側面の X1/X2 出力へ送る設定をします。 
 
L/R 出力と X1/X2 出力のオーディオ・ソースは、LR ミックス（ステレオかモノラル）だけでなく、ヘ
ッドフォン出力ソースと同じオーディオ信号（ステレオかモノラル）を割り当てることができます。ヘ
ッドフォン・ソースを割り当てて、セカンダリー・ヘッドフォン出力として利用できて便利です。 
 
 
 
 
 
 
 
 
 
 
 
 
 

Adjusting Output Level 
 
出力ゲインの調整は、トランスミッター、外部ミキサー、PA など、出力に接続された機材へ送る信号
を適切なレベルにするために重要です。出力ディレイは、プロダクションでビデオ・オペレーターに
オーディオを送る時に、カメラ映像とオーディオの同期を合わせるために用いられます。 
 
出力ゲインとディレイを調整するには： 
 
1.    をタップします。 

 
2. Outputs をタップします。 

 
3. 次のいずれかを選択します。 

 
・LR Gain 
・X1X2 Gain 
どちらもゲインの調整範囲は 0～ -40dB です。 
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Outpu Muting 
 
MixPre-10M で、3.5mm stereo output をミュートにできます。 
 
出力をミュートするには： 
 
1.       をタップします。 

 
2. Outputs をタップします。 

 
3. St Out Mute をタップします。 

これは、Mute の On/Off を切替えます。 
 

Info: Output Mute 機能はショートカットに設定できます。 
 
 

Headphone Out and Presets 
 
MixPre-10M のオーディオ愛好家向けヘッドフォン・アンプリファイアは、ハイパワーで低ノイズなの
で、MixPre-10M が取扱うオーディオを正確にヘッドフォンや環境に関係なくモニターすることができ
ます。 ヘッドフォンプラグを（右側面にある）3.5mm ジャックに接続してください。 ヘッドフォン
音量ボリュームは、ヘッドフォンジャックの隣にあるエンコーダで調整することができます。 
 

Info: ヘッドフォン出力アンプは非常に大きなレベルを出力する能力があります。不適切な音
量調整のままヘッドフォン装着していると聴覚障害を起こすので御注意下さい。 

 
Menu 画面から、画面の左上にあるヘッドフォンのアイコンにタッチして、ヘッドフォン・
プリセット（HP Presets）にアクセスすることができます。 このアイコンの上に、現在選択
されている HP プリセットが表示されます。 
 

HP Presets メニューで、さまざまなプリセットを選択できます。 
 
 
 
 
 
 
 
 
 
 
オプション： LR Stereo, LR Mono, Preset 1-4, Edit HP Preset 
 
 
カスタム HP プリセットを作成するには： 
 
 HP Preset メニューで、User HP Preset の編集や名前を付けるために、Edit HP Preset を選択し

ます。 
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Metering 
 
 
 

LEDs and Metering 
 
MixPre-10M はインプットとアウトプットのレベルを確認するためにいくつかの方法があります。 
チャンネル・ノブのリング LED、チャンネル画面メーター、Home 画面のメータービュー。 
 

Channel Knob Ring LEDs 
 
・ チャンネル・ノブ・リング LED – 各 LED リングは、グリーン、オレンジ、レッドに光ります。 

LED リングの明るさは、インプットのレベルに応じています。 グリーン = 信号有り、レッド = 
シグナル・ピーキング、オレンジ = リミッター機能動作中。 また、チャンネル・ソロ中は、チ
ャンネルのリング LED がオレンジで点滅し、ミュートされたチャンネルは赤く点灯します。 

 
 
 
 
 
 
 
 
 
 
下側４つ（5,6,7,8）のリング LED がオレンジ色で点滅するのは、トラック・バンクが切替えられた後
に、ノブ(5,6,7,8)の回転位置とストアされているフェーダー値が一致していないことを示しています。
ノブを調整してフェーダー値と一致すればオレンジ色の LED は消灯します。 
 
 

Channel Screen Meter 
 
チャンネル画面では、トラックネームのすぐ下にレベルメーターが表示されます。 
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Meter View 
 
Home 画面のメータービューには、12 トラック分の垂直指示バーメーターが表示され、L/R ミックス
は水平バーメーターが表示されます。メータービューにはトラック・バンク・セレクターも表示され、
これはメーターグループを囲う白い枠線です。例えば、次の図では、トラック 1-4 と 9-12 が選択され
ています。 
 
 
 
 
 
 
 
 
 
 
メーターの下側に表示されるトラック番号が振られたラベルは、ルーティングやトランスポート状況に
応じて色が変わります。 
 
 
 
 
 
 
 
 
 
 
次の表は、楽曲制作に中に見ることができるさまざまなオプションを示します。 
 

トラックラベル 詳細 

赤 録音アーム状態、ライブインプットをモニター中。 

緑枠の中に赤 録音アーム状態、トラック再生をモニター中。 

緑 トラック再生中。 （録音しない状態） 

グレイ（停止時） トラックにインプットソースがアサインされていて、録音しない状態。 

黒 トラックにインプットソースがアサインされていない。 
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Projects 
 
 
MixPre10-M の中では、歌や楽曲をプロジェクトとして取扱われます。プロジェクトとは本質的には、
SD カードの１つのフォルダの中に格納されたすべてのオーディオ・ファイルとミキシング・セッティ
ングを指します。 ユーザーによって創作された楽曲はフォルダで管理されるため、バックアップやコ
ピーも簡単です。プロジェクト・フォルダには特別な「セッション」ファイルも含まれ、これは、録音
されたオーディオ・ファイルがどのトラックで、またどのタイムラインで再生されるかを MixPre-10M
が正確にコントロールするためのファイルです。 
 
概念的に、１つのミュージック・プロジェクトは一般的な DAW と同じく働き、ユーザーが思い描く通
りのものです。 プレイ・カーソルは水平タイムライン上を移動し、複数のオーディオ・トラック（MixPre
の中ではチャンネルとして扱われる）が縦に並びます。 局は常に 00:00:00:0 (hh:mm:ss:tents)か
らスタートします。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
ユーザーは多くのプロジェクトを 1 枚の SD カードに収めることができるだけでなく、異なるプロジェ
クトへすばやく切替えられるので、アルバム制作など複数曲の平行作業にも柔軟に対応できます。 な
お、MixPre-10M では一度に１つのプロジェクトだけをアクティブに操作できます。 
 
すべてのプロジェクト・オーディオ・ファイルとセッティング（例えば、ミックスパラメータ、トラッ
クネーム、プロジェクトヒストリーなど）は自動的に保存されるので、手動保存のし忘れは心配はあり
ません。 
 
もし録音最中にトラブルで電源を突然失っても、再通電するだけで直前のプロジェクト状態に戻ります。
そして電源が失われる直前まで録音されていたオーディオは壊れることも失われることもありません。 
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Creating Projects 
 
 
MixPre-10M は、新規プロジェクトを意識して用意しなくても、record が押されると自動的にプロジェ
クトが作成されます。 
 
新規ミュージック・プロジェクトを作成するには： 
 
1.      をタップします。 

 
2. Project > New をタップします。 

 
 
 
 
 
 
 
 
 
 

3. 新規 Music Project 画面が表示されたら、次のいずれかを操作します。 
 
 プロジェクトネームを編集する。 
 サンプルレートを設定する。 

オプション：44.1kHz, 48kHz, 96kHz 
 

Info: 新規プロジェクト作成時は正しいサンプルレートを選んでください。 この設定はプロ
ジェクトが作成された後に変更することができません。 
 
USB オーディオインターフェースとして 10M を使う時、コンピュータ OS, DAW アプ
リケーション、10M のプロジェクトが同じサンプルレートであることを確認してくださ
い。 これはクロック問題、オフスピード再生の回避となります。 

 
4. 新規 Music project を作成する準備が整ったら、Create をタップします。  
 

Info: 新プロジェクトネームは Home 画面の上に表示されます。 
 
 

Import Recording 
 
新規プロジェクト作成時、.wav オーディオファイル（12tracks まで）をプロジェクトの基礎としてイ
ンポートできます。 DAW からマルチトラックオーディオをインポートして、MixPre で楽曲制作を続
けることができます。あるいは、ライブパフォーマンス用に DAW で作成したバッキング・トラックを
インポートして、MixPre をパフォーマンス中の再生装置とミキサーを兼ねるオールインワンデバイス
に利用できます。 
 

Info: MixPre-3, 6, 10T の Audio プロジェクトで録音された.wav ファイルを、Music プロジ
ェクトにインポートすることもできます。ファイルネームは 40 文字以下にしてくださ
い。長いファイルネームはサポートされません。 
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非ネイティブ WAV ファイルをベースに新規プロジェクト作成： 
 
1.       をタップします。 

 
2. Project > New > Import recording をタップします。 

 
3. SD カード上のインポートしたいファイルを選びます。 

 
＞ HP エンコーダを操作して SD カードのルートにある.wav ファイルを選択します。 
＞ Audio プロジェクト・フォルダを選択し、その中の.wav ファイルを選択します。 
 

 
 

Opening Projects 
 
現在のプロジェクトから別のプロジェクトへ切り替える時、現在のプロジェクトへのセーブを懸念する
必要はありませんん。MixPre は現在のプロジェクト状態を自動的に保存しているからです。 
 
以前に作成したプロジェクトを開くには： 
 
1.      をタップします。 

 
2. Project > Open をタップします。 SD カード上に、すべてのプロジェクトがリスト表示され、ミ

ュージックノートアイコン     で見分けることができます。 
 
 
3. HP エンコーダを操作してプロジェクトの１つをハイライト状態にします。エンコーダを押すとプ

ロジェクトを開きます。 
 
そのプロジェクトが開かれたら Home 画面が表示されます。これで録音スタートできます。 

 
 

Copying Projects 
 
SD カードに保存されているプロジェクトを手動でコピーしたり、現在アクティブなプロジェクトを自
動的に USB サムドライブへコピー（バックアップ）することができます。これはユーザーのプロジェ
クトをシェアしたりバックアップするには理想的です。 
 
アクティブ・プロジェクトをオートコピーするには： 
 
1. USB サムドライブを USB-A ポートに接続します。 

 
2. もし、USB サムドライブが MixPre-10M でフォーマットされていなければ、最初にフォーマット

してください。 
 
重要：フォーマットするとすべてのデータが消去されます。 
 

3. これで設定は終了です。MixPre-10M は自動的にアクティブ・プロジェクトを SD カードから USB
サムドライブにコピーします。 
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USB サムドライブに手動でコピーするには： 
 
1. USB サムドライブを USB-A ポートに挿入します。 

 
2. もし USB サムドライブが前もって MixPre-10M でフォーマットされていない場合、まず最初にフ

ォーマットを行ってください。 
 

重要：フォーマットするとすべてのデータが消去されます。 
 
3.      をタップします。 

 
4. Project > Copy をタップします。 

（USB サムドライブが接続されていない時は、Copy をタップできません。） 
 

5. エンコーダを操作して、プロジェクトを１つ選択します。 
 

6. OK をタップしてコピーを実行します。 
 
重要：コピー作業中は USB サムドライブを抜かないでください。 
 

 

Trashing Projects 
 
メディア容量がギガバイト級の SD カードを使用すると、プロジェクトのリストはかなり長くなります。 
現在アクティブなプロジェクトを除いて、不必要なプロジェクトを削除することができます。 
 
 
プロジェクトを削除するには： 
 
1.      をタップします。 

 
2. Project > Trash をタップします。 

 
3. 選択されたプロジェクトの削除を確認するための OK をタップします。選択されたプロジェクトと

関連するすべてのファイルが TRASH フォルダに移動されます。コンピュータから TRASH フォル
ダにアクセスすることは可能です。 

 
 

Info: SD カードの空き容量を増やすために、TRASH フォルダ内のデータを完全に削除するに
は、 SD Card > Empty Trash を実行してください。 

 
 
 

Project History 
 
録音されるごとに、ヒストリーリストの中にアイテム（リビジョン）として記録されます。ここから、
前の録音テイクへ「アンドゥ」したり、後の録音へ「リドゥ」したりと、異なる複数テイクと比べたり、
悪いテイクをすばやくリドゥすることができます。ヒストリーリストは年代順に表示し、最も新しいレ
コーディングをトップに表示します。 
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ヒストリーリストで、前／後のレコーディングに切り替えるには： 
 
1. Home 画面の左上の     をタップします。 

 
2. History をタップします。 ヒストリーリストが表示されます。 

 
 
 
 
 
 
 
 
 
 
 

3. HP エンコーダを操作してリストの中のファイルをを１つ選択します。現在のレコーディングがア
スタリスクマーク（*）がファイルネームの右に表示されます。 

 
Info: リビジョンのファイルネームは録音完了の日付と時刻を元にしています。例えば、2018

年 3 月 12 日の 2:22PM(14:22)に録音完了したファイルは 001-031218-142200 と
なります。 

 
スクラッチから現在のプロジェクトをリスタートするには： 
 
ヒストリーリストから、一番下にスクロールし、Restart Song を選択します。 
 

Info: これはプロジェクトからすべてのオーディオをクリアし、もとに戻すことはできませ
ん。しかし、オーディオ・ファイルそれ自体が削除されることはありません。それら
はプロジェクト・フォルダに残っており、コンピュータからアクセスできます。 

 
 
 

Project Folder Structure 
 
１つのプロジェクト・フォルダにはつぎのファイルが含まれます。 
 プロジェクトの録音されたオーディオ WAV ファイル。 トラックで録音された、またはオーバー

ダブされたものは、シングルのモノフォニック WAV ファイルです。 
 

Info: ファイルネームは録音完了の日付と時間を元にしています。例えば、2018 年 3 月 23
日 1:33PM(13:33)に録音完了したファイルは 001-032318-133300 となります。 

 
 １つのレンダーフォルダは、すべてのレンダーされたオーディオ・ファイルと、１つの

SESSION.XML ファイル（プロジェクト用に保存されているセッティングとオーディオ・ファイル
の再生状況を管理する）が含まれます。 

 
プロジェクト・フォルダのコンテンツをコンピュータで確認することができます。 
 
 

Sharing Projects 
 
シェアリング・プロジェクトは、簡単にコンピュータへ転送して、インターネットで仲間にアップロー
ドしたり、SD カードや USB サムドライブを手渡ししたりできます。 
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プロジェクトを共有するにはいくつかの方法があります。 
 
 プロジェクト・フォルダのコピー： MixPre-10M ユーザー同士での受渡しに適します。SD カード

からプロジェクト全体をロードすることができ、プロジェクト作業を継続できます。 
 Wav か AAC ステレオファイルにレンダー： 友人やバンドメンバーに最終ミックスを渡すのに適

します。 
 

Info: AAC ファイルは、.mp3 オーディオ・ファイルのようなもので、同じビットレートで
あれば AAC のほうが良い品質を期待できます。 

 
 すべてのトラック（ISOs として録音された）をモノフォニック・ファイルとしてレンダー： DAW

にインポートしてプロダクション作業を続けるのに適します。 
 
プロジェクトをレンダーするには： 
 
1.      をタップします。 

 
2. Render をタップします。 

 
 
 
 
 
 
 
 
 
 
 

3. レンダー後のファイル形式を設定します。 
オプション： Wav Stereo か AAC Stereo 

 
 Wav Stereo:  非圧縮の 2ch ステレオ wav ファイルに LR ミックスをリアルタイムにレンダーし

ます。 レンダリング中の、トラックレベル、パン、ミュート、リバーブ、エアーエフェクトのす
べての調整はステレオ wav ファイルに反映されます。 
 

 AAC Stereo:  圧縮された 2ch のステレオ AAC ファイルに LR ミックスをリアルタイムにレンダ
ーします。AAC ファイルは WAV ファイルと比べてかなり小さいサイズなので、インターネットで
共有するのに適します。 レンダリング中の、トラックレベル、パン、ミュート、リバーブ、エア
ーエフェクトのすべての調整は AAC ファイルに反映されます。 

 
Info: AAC 用のビットレートは、メイン menu の Record > AAC Quality の、 32, 64,128, 

192, 256 kbps から選択できます。数値が大きいほど、品質が良くなります。 
 
 Wav All Isos:  すべてのアイソレート・トラックをそれぞれモノフォニック・wav ファイルへリ

アルタイムにレンダーします。DAW にすべてのトラックをインポートするのに適します。 すべて
のファイルを DAW のタイムラインのゼロポジションにドラッグするだけで、トラック間のタイミ
ングが完璧に揃います。 
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Recording and Playback 
 
 
 
MixPre-10M は、業界標準 WAV ファイル形式で SD カード（SD, SDHC, SDXC）に 96kHz, 24-bitｄ
で最高 12 オーディオトラックまで録音することができます。 安心してお使いいただけるよう、SD カ
ードにオーディオを録音しながら MixPre-10M は USB-A ポートに装着された外部 USB サムドライブ
に自動的にコピーする機能を持ちます。これはバックアップ目的として、またセッション終了直後に
コピーをすぐ渡せるという意味でも理想的です。 また、アクティブなプロジェクトだけでなく事前に
保存されたプロジェクトなど、どのプロジェクトでも手動でコピーすることができます。 
 
MixPre-10M は、USB オーディオインターフェースとして使用しながら、SD カードに録音することが
できます。コンピュータの USB オーディオ出力を録音したり、MixPre-10T に接続されているマイクや
ラインソース機器とミックスしたりできます。 
 
レコーディングと USB オーディオストリーミングを同時に行う能力により、コンピュータ録音に対し
てのバックアップレコーダーとして MixPre-10T を利用することもできます。 特に、コンピュータ 1
台のみに頼るにはリスクのある重要なイベントの録音に最適です。 
 
 

Formatting SD Cards & USB Thumbdrives 
 
信頼性を持った録音・再生のために、SD カードは必ず MixPre-10M でフォーマットされていなければ
なりません。  
 
USB サムドライブが USB A ポートに挿入されている場合、MixPre-10M は自動的に現在のプロジェク
トで録音されたファイルをそれにコピーします。 この USB ドライブも使用する前に必ず MixPre-10M
でフォーマットされていなければなりません。 
 

Info: メディアをフォーマットするとその中にすべてのデータが消えるため、フォーマットす
る前に必要なデータを必ずバックアップしてください。 

 
MixPre-10M には、最高のパフォーマンスを提供するために最適化された Sound Devices 社ブランド
の SD カードを御使用されることを強くお勧めいたします。推奨されるメディアがお手元にない場合、
もっとも信頼できる製造元（SanDisk か Delkin）のメディアで、class 10 speed を満たすかそれ以上
のものが望ましいです。USB サムドライブに関して、動作の信頼性のために Sound Devices の認証メ
ディア(Approved Media) の使用を強く推奨します。 
 
 
SD カードをフォーマットするには： 
 
1. 背面パネルに位置する挿入口に SD カードを挿入します。 

 
2.    をタップします。 

 
3. SD Card > Edit > Format とタップします。 

 
4. カードをフォーマットする確認画面が表示されたら、OK をタップします。 
 
容量が 32GB 以下の SD カードは FAT32 ファイルシステムでフォーマットされます。それより大きな
容量の SD カードは exFAT ファイルシステムでフォーマットされます。 
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USB サムドライブをフォーマットするには： 
 
1. 背面パネルに位置する挿入口に SD カードを挿入します。 

 
2.    をタップします。 

 
3. USB Drive > Edit > Format とタップします。 

 
4. メディアをフォーマットするためのコマンドの確認を求められたら、OK をタップします。 メデ

ィアは exFAT としてフォーマットされます。 
 

Info: exFAT ファイルシステムは、Windows XP や Mac OSX 10.6.4 以前に互換性がありま
せん。 

 
 
 

Transport Controls 
 
フロントパネルにあるジョイスティック（と点灯式 LED リング）は、さまざまなトランスポートコン
トロール操作に使用することができます。 
 

ファンクション コントロール 詳細 

 

録音 

 

 

 新しくファイルを録音開始するときに押します。 録音中、LED リング

が赤く自照します。 

 

停止 

 

 録音中に押すと停止します。 再生中に押すと停止します。 スタンバイ

中に押し続けると、次に録音するテイクのテイクネームが表示されま

す。 

 

再生 /  

ポーズ 

 

 再生中、ボタンは緑色で自照します。 

押すと、現在位置から再生を開始します。 再生中にこれが押されると、

その位置でポーズ状態になります。 

もし曲の最後で押されても、何も反応しません。 

 

早戻し/  

前テイク呼出 

 

 スタンバイ中に押すと前のテイクをロードします。 再生中に押し続け

ると早戻しします。 再生中かポーズ中に押し続けると、2x 速で早戻し

を始め、5 秒後に x16 速まで加速します。 

 

早送り / 

次テイク呼出 

 

 スタンバイ中に押すと次のテイクをロードします。 再生中に押し続け

ると早送りします。 再生中かポーズ中に押し続けると、2x 速で早送り

を始め、5 秒後に x16 速まで加速します。 

 

Scrub 

 

 再生か再生ポーズ中、ヘッドフォン・エンコーダーを長押しするとスク

ラブモードに入ります。時計回転方向にまわすと早送り、反時計方向に

まわすと早戻しになり、速度は 1/8x, 1/4x, 1/2x, 1x, 2x, 4x, 8x, 16x 

です。オーディオは 2 倍速まで聴くことができます。 
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Record Arming 
 

Record Arming 
 
アームされたトラックは、REC 作動時に録音されます。 PLAY 作動時は再生されます。 
 
アーム解除されたトラックでは、インプットモニターの On でないかぎり、録音か再生のどちらが作動
中でも再生します。(インプットモニターが On だとライブインプットをモニターします。) 
 
チャンネルをアームするには： 
 
1. チャンネル・ノブを押します。 

 
2. Arm をタップします。 

 
アームされたチャンネルは、メーター・ビューの中でチャンネル番号を囲むラベルが赤く表示さ
れます。 もし隣りのチャンネルとステレオリンクされている場合、それらのラベルが合体してリ
ンクされていることを示します。 
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Working with Q-points 
 
MixPre-10M は、任意の演奏開始ポイントやオートマチック・パンチ IN/OUT ポイントへ簡単にロケー
トするために Q ポイントを利用します。 
 
Q ポイントは異なるタイプがあります。 
 

アイコン タイプ 詳細 

 Play In 再生開始点の指定。一般的にパンチイン(Record In)前のプリロール

として使用されます。 

 Record In 自動的に録音開始点の指定。（パンチイン・アウト領域の開始点） 

 

 Record Out 自動的に録音終了点の指定。（パンチイン・アウト領域の終了点） 

 

 Stop 再生停止点の指定。 一般的にパンチアウト(Record Out)後のポス

トロールとして使用されます。 

 Cue mark 

(Q01, Q02,etc) 

キューマークは曲中で任意のポジションにマークでき、すばやく簡

単にロケートすることができます。例えば、コーラス開始点 Q ポイ

ントを設定し、このキューポイントにわかりやすい名前をつけるこ

ともできます。 

 
 
Q ポイントを追加するには： 
 
1. 停止中に、Q アイコン     をタップします。Home 画面にもどると、Q-Points メニュー画面が標

示されます。 
 
 
 
 
 
 
 
 
 
 

2. 追加したいキューポイントに相当するボタンをタップします。キューポイントの追加は、停止中、
ポーズ中、再生中のいずれも可能です。 
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Info: Out ポイントを置いた後に In ポイントを置くことはできません。各タイプ（Play か
Record）の In か Out ポイントは 1 つ以上置くことはできません。 

 
また、Play In、Record In/Out、Stop ポイントを Q-List からキューマークを作成することができます。 
 
キューマークを追加するには： 
 
 録音中、再生中、ポーズ中に、その曲のまさにそのタイミングで、Q アイコン    （Home 画面の

上部にある）をタップします。キューマーク番号（Q01 から始まり、新しいキューが追加されるた
びに増えていく）は、Q アイコンの隣に表示されます。 
 

 また、停止した状態で Home 画面の上部にある Q アイコン    をタップして Q-Points メニュー
にアクセスします。 次に、Q ボタン      をタップして、現在の曲ソングポジションでキューを
追加できます。  

 
すでに存在しているキューマーク間に割込んで新しくマークを追加した場合、MixPre は自動的に番号
を振りなおし、曲の開始から Q01, 02, 03, etc と並べ替えられます。 
 
キューは、Q-List の中に数字で表示されます。次の図例は、Q-Points 画面の中で、Play In、 Record 
In/Out、Stop の下に 01 と表示されています。 
 
 
 
 
 
 
 
 
 
 
1 曲につき最大 20 個のキューポイントを作ることができます。キューに名前をつける、移動、削除、
あるいは Q-List から Play In, Record In/Out, Stop ポイントとして設定することができます。 
 

Info: Playback か Record In/Out ポイントに名前をつけることはできません。 
 
 
 
Q-List にアクセスするには： 
 
 Music Control メニューから 
 Q-Points メニューから 
 
 
 
１つのキューマークに名前をつけるには： 
 
1. Q-List にアクセスし、Q-Points 画面を表示させます。 
2. HP エンコーダを使用して１つのキューマークを選択します。 
3. Name をタップし、 Chorus や Bridge といった新しい名前を入れます。 
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Play In, Record In/Out, Stop ポイントとしてキューを設定するには： 
 
1. Q-List から、キューを１つ選択します。 
2. Set As をタップします。 
3. Play In, Record In, Record Out, Stop のいずれかをタップし、選択されたキューを変更します。 
 
 
 

Moving Q-Points 
 
登録されたキューの時間を 0.1 秒単位で変更することができます。 
 
Q-points を移動するには： 
 
1. Q-List をタップします。 

 
 
 
 
 
 
 
 
 
 

2. HP エンコーダを操作して、1 つの Q-point を選択します。 
 

3. Move をタップするか、HP エンコーダを回して、選択された Q-point を 0.1 秒単位で調整してく
ださい。 
 

 

Previwing Q-Points 
 
Q-point のポジションをファイン・チューニングするために、プレビューすることができます。 プレビ
ューは、Q-point から数秒間を再生します。もし Q-points がわずかに遅いまたは早い場合、ムーブ機
能を使ってそのポジションをファイン・チューンしてください。 
 
Q-Points をプレビューするには： 
 
1. Q-List から Q-point を選択して、Play を押します。 
 
 
 



 

   

 

 

  45 

 

 
 

Clearing & Deleting Q-Points 
 
Q-Points メニューか Q-List 画面で、キューマークの削除、Play In, Record In/Out, Stop のマークを
クリアすることができます。 
 
In と Out 値をクリアするには： 
 
 Clr In/Out をタップします。 
 
 
個々の Play In, Record In/Out, Stop ポイントをクリアするには： 
 
Q-List から、あるいは１つを選択し、Disabl をタップします。 
 
 
キューマークを削除するには： 
 
1. Q-List から、キューマークの１つを選択します。 
2. Delete をタップします。 
 
 

Locating to Q-Points 
 
曲のある場所に “キュー” したい場合、ジョイスティックの (<<, >>) 位置ですばやくキューマーク
へジャンプすることができます。 
 
キューマーク間へジャンプするには： 
 
 ジョイスティックを右（>>）へ倒すと次のキューマーク位置へジャンプし、左（<<）へ倒すと前

のキューマーク位置へジャンプします。 
 
 

Punching In/Out 
 
パンチングは、アーム解除されたオーディオデータのあるトラックを再生しながら、アームされたトラ
ックの in と out の位置で録音状態にする機能です。 オートマチック・パンチングは一般的に使われる
テクニックで、オーディオが存在するトラックを再生しつつ、自動的に途切れなくあらかじめ決められ
たポイントで録音のドロップイン・アウトさせることができます。新しいトラックへ、または、すでに
オーディオが存在するトラック上にも、パンチイン・アウトできます。 
 
すでに素材が存在する上にパンチイン・アウト（オーバーダビングと呼ばれる）は、すでに録音された
トラックの音で、Record In と Out で指定された領域に新しくオーディオを置くことです。 
 
 
手動でパンチイン・アウトするには： 
 
1. パンチイン・アウトしたいトラックをアーム状態にします。 

 
2. 再生中に、任意のタイミングでパンチインするために REC を押します。 MixPre はアームされた

トラックに録音します。 REC コントロールは明るく赤色に点灯します。 
 

3. もう一度 REC を押すとパンチアウトします。MixPre は再生を続けながら録音だけ停止します。 
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自動的にパンチイン・アウトするには： 
 
1. MixPre を自動的にパンチイン・アウトさせたいところに、Record In と Record Out ポイントを

設定します。 Record In か Out ポイントが設定されると、オートマチックパインチングが有効で
あることを示す ’P’ がステータス・バーに表示されます。 
 

2. 必要に応じて、pre-roll と post-roll を設定するために、Play In と Stop の Q-Points を使用し
ます。Pre-roll をセッティングすることで、すでに録音された演奏を Record In ポイントより手前
から再生することができるので、パンチイン用の演奏がリズミカルかつスピーディに行えます。お
好みに応じて、pre-roll と post-roll 中のモニターソースを Track ‘Monitor’ ボタンを使って、ト
ラック再生かライブインプットのどちらかに設定できます。 
 

3. REC を押します。 トランスポート・ジョイスティック LED が緑色に点灯し、MixPre は（設定さ
れていれば Play In ポイントから、そうでなければ現在のプレイバック・カーソル位置から）再生
を開始します。再生しつつ、Record In ポイントに達すると、MixPre はアームされたトラックで
自動的に録音開始し、ジョイスティック LED が赤色に点灯します。録音は、Record Out ポイント
までつづき、そのポイントで MixPre は再生状態に戻り、ジョイスティック LED が緑色に点灯しま
す。再生は、Stop ポイントに達すると停止します。 

 
 

Bouncing 
 
MixPre-10M は、多くのシチュエーションに対応できる最大 12 トラックのレコーダーです。例えば、
ドラム用に 4、ベース用に 1、ヴォーカル用に 2、ギター用に 2、キーボード用に 2 トラックを使用し
てもスペアに 1 トラック残ります。 
 
しかし、ときにはもっと多くのレイヤーが必要となるかもしれません。ピンポンと呼ばれるバウンシン
グ機能は、ビートルズやビーチボーイズなどが活躍した時代のテクニックで、オーバーダビング用の空
トラックを作るためにマルチトラックを１つか２つにコンバインすることです。これは、マルチトラッ
クをグルーピングすることでの単純なミックスダウン、あるいは ISO トラックにリバーブやエアーエフ
ェクトをかけることにも用いることができます。 
 
MixPre では、バウンス・ミックスは LR ミックス機能を利用しています。 
 
バウンスするには： 
 
1. バウンスしたいトラックを決めます。 これをディスティネーション・トラックと呼びます。 

 
2. ディスティネーション・トラックのチャンネル画面で、Input を MixL、MixR、または両方 に設定

します。 このチョイスは、バウンスしたいものがモノ、ステレオ、デュアルモノであるかで決ま
ります。例えば、track-1 と 2 にステレオバウンスする場合、track-1 を MixL に、track-2 を MixR
に設定します。もしも track-3 にモノラル・バウンスする場合は、track-3 を MixL と MixR の両方
に設定します。 

 
Info: MixL か MixR に設定されたトラックは、フィードバックを防ぐために LR mix から取り

除かれます。 録音されるバウンスのレベルを LR ゲインコントロールで調整することが
できます。 Home 画面の L(left)ミックスメーターをタップしてすばやく LR ゲインに
アクセスできます。 
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3. バウンス元のトラックを決めます。 これらをソース・トラックと呼びます。 

 
4. ソースとディスティネーション・トラック以外のすべてのトラックを Mute にします。 

 
5. ディスティネーション・トラック以外のすべてのトラックをアーム解除します。 

 
6. ソース・トラックの levels, pans, reverb, air effects を必要に応じて設定します。 エフェクトは

ディスティネーション・トラックに反映されます。 
 

7. これでバウンスの準備が整いました。 
 

8. 手動で録音開始するか、オート・パンチイン機能でバウンシングを開始します。 ノーマル録音と
なるので、リアルタイムにソース・トラックの levels, pans, effects を動的に調整することができ
ます。 
 

9. バウンスを止めたいときに Stop を押して停止できます。 
 

10. ディスティネーション・トラックから MixL と MixR の送りとアームを解除します。 
 

11. バウンスの結果を聴くには、バウンスがスタートされた場所から再生を開始します。ミックスレベ
ル、pan, reverb, air を調整してください。 

 
バウンス・トラックだけをモニターするには、オリジナルのソース・トラックを mute するか削除して
ください。 
 
 
トラックをクリアするには： 
 
1. チャンネル画面にアクセスします。 

 
2. Input をタップし、次に Clear をタップします。 

 
 
 
 
 
 
 
 
 
 
Clear コマンドは、トラックにオーディオデータがあるときだけ表示されます。 
 

3. Yes をタップして、プロジェクトからのトラック・オーディオ取外しを確認します。 
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Metronome 
 
メトロノームは、録音中に演奏を始めるタイミングをとるため、あるいは再生がいつ始まるかをカウン
トインで知らせる機能です。バーの最初のビートは他のビートよりも高いピッチで鳴ります。メトロノ
ームのクリック音は LR ミックスと合成され、ヘッドフォンや LR に設定された出力端子で聴くことが
できます。 
 
メトロノームの設定をするには： 
 
1.      をタップします。 

 
2. Metronome をタップし、必要な設定を行ってください。 
 
 
 
 
 
 
 
 
 
 

Info: 画面表示中は、メトロノームのプレビュー音を聴くことができます。 
 
 Sginature をタップして拍子を設定します。 

オプション： 1/4, 2/4, 3/4, 4/4, 5/4, 6/4, 7/4, 8/4, 6/8, 7/8, 9/8 
 Tempo をタップしてテンポ（クリック音のレート）を HP エンコーダで bpm (beats per minute)

値を設定します。 範囲は 40 ～ 240 bpm。 
 Volume をタップしてメトロノームの音量を調整します。 
 Count-in をタップして、録音開始前のカウント数を設定します。範囲は 0～8 bars。 
 On During…をタップしていつメトロノームがアクティブになるかを設定します。 

オプション： Record, Play, Count-in 
 

 
メトロノームを有効にするには： 
 
Music Control メニューからメトロノームボタン   をタップします。アクティブになると、メトロノー
ムのアイコンがオレンジ色で表示されます。 
 
 
 
 
 
 
 
 
 
 
 

Info: トラックのインプット・ソースにクリック音がアサインされると、メトロノームボタンは
無効（グレイアウトでオレンジ色のアイコン表示）です。 

 
 



 

   

 

 

  49 

 

 
 

Record Settings 
 
Record サブメニューでは、次の表のように詳細な設定項目があります。 
 

サブメニュー 詳細 オプション 

L&R Gain LR ミックス用のゲイン設定 ・ -30 – 0 dB (1dB ステップ) 

 Info: Home 画面で L(left)水平メーターをタップすると、L&R ゲインにすばやくアクセ

スすることができます。 

AAC Quality AAC 用レンダリングの品質設定。 

 

・ 32 kbps 

・ 64 kps 

・ 128 kbps 

・ 192 kbps 

・ 256 kbps 

 
Record サブメニューにアクセスするには： 
 
     をタップしてから、Record をタップします。 
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USB 
 
 
 

USB Audio  Interface 
 
MixPre-10M は、12-in, 4-out の Mac か PC コンピュータと使用するための core audio コンパチブル
なオーディオ・インターフェースを内蔵しています。  
 
PC ユーザーの場合、特定の ASIO ドライバーがインストールされない限り、2x2 オーディオインター
フェースとして MixPre-10M が認識されます。 
 
 
最新の ASIO ドライバーとインストールインストラクションは、以下から無料でダウンロードできます。 
www.sounddevice.com/support/downloads  
 
ホストコンピュータから USB オーディオとして働かせるには、USB 1-4 ソースを適切にルートする必
要があります。 ホストコンピュータからのUSB オーディオとMixPre-10Mの入力であるライブオーデ
ィオを一緒に LR バスへ送ってミックスしたい場合、チャンネル画面を使ってインプットソースを選択
してください。 USB ホストコンピュータオーディオをヘッドフォンで聴くだけであれば、HP プリセ
ットを USB 1,2 か USB 3,4 に設定してください。 
 
 
MixPre-10M は USB ホストへのストリーミング・オーディオと録音を同時に行う能力があります。 ま
た、コンピュータからの USB オーディオ・ストリーム出力を SD カード・レコーダーで直接録音する
能力もあります。 これはあらゆるコンピュータベースの録音作業において非常に便利な機能です。 
以下の表は、MixPre-10M のチャンネルが USB オーディオの出力へアサインされる詳細について示し
ます。 
 

サブメニュー 詳細 

Track 1 USB stream 1 

Track 2 USB stream 2 

Track 3 USB stream 3 

Track 4 USB stream 4 

Track 5 USB stream 5 

Track 6 USB stream 6 

Track 7 USB stream 7 

Track 8 USB stream 8 

Track 9 USB stream 9 

Track 10 USB stream 10 

Track 11 USB stream 11 

Track 12 USB stream 12 

 
 

http://www.sounddevice.com/support/downloads
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Low-latency Monitoring 
 
レイテンシ（オーディオのプロセッシング・ディレイ）を小さくするために、ハードウェア、ロジック、
ソフトウェアのデザインチームは非常に苦労して MixPre-10M を設計しました。 多くの状況において、
DAW(Digital Audio Workstation)を通してモニタリングするときのレイテンシは、DAW ソフトウェ
ア、プラグイン、コンピュータのハードウェア次第で、完全に許容範囲にあります。 
 
スループット・レイテンシが望まれるものよりも高い場合（遅延時間が長い）には、MixPre-10M に入
力される信号をヘッドフォン出力で直接モニターすることができます。 
 
 
Zero レイテンシでヘッドフォンモニターするには： 
 
1. MixPre-10M をコンピュータに接続します。 

 
2. HP Preset として “LR Stereo” が選択されていることを確認します。 

 
3. Track 11 用に”USB1” を選択し、Pan L にします。 

 
4. Track 12 用に”USB2” を選択し、Pan R にします。 

 
5. Track 1 にマイクロフォンか楽器などのソースを接続します。 

 
6. DAW ソフトウェアで USB ストリーム 1 がソースとなる新しいトラックを設定し、このトラック

のレコード・モニタリングが無効であることを確認します。 （また、念の為に DAW 内のトラッ
クの出力をミュートしておきます。） 
 

7. Track 11, 12 を通して DAW オーディオの出力を調整し、ヘッドフォンで聴くことができます。 
また、Channel 1 のノブを使用してヘッドフォンでモニターされる低レイテンシ（と DAW に送ら
れるレベル）を調整することができます。 Channel 1 と DAW オーディオの（モニター）ミック
スを調整するには、Channel 11, 12 のノブを使用します。 
 

 

USB File Transfer 
 
MixPre-10M は、USB 接続されたホストコンピュータと内蔵 SD カード間のファイル転送をサポートし
ます。 この機能を使うには、MixPre-10M を File Transfer モードにしなければなりません。（USB オ
ーディオ機能は無効になります。） 
 
 
SD カードをフォーマットするには： 
 
1.    をタップします。 

 
2. System > File Transfer とタップします。 

 
3. ファイル転送が完了したら、コンピュータを操作して SD カードをアンマウントします。 次に

USB-C File Trnaser モード画面の Exit をタップして、前の運用状態に戻します。 
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USB Keyboard 
 
スタンダード USB コンピュータ・キーボードをサポートしています。 MixPre-10M を使用していて、
メタデータ入力、タイトル入力、ワイヤーリモートコントロール機能が必要とされるときは、USB キ
ーボードを接続してください。 
 

Info: USB ハブが内蔵されたキーボードや Apple 製のキーボードはサポートしていません。 
また、MixPre-10M の電源を入れた後に接続しないと認識されないものもあります。 

 
接続された USB キーボードは、MixPre-10M のいくつかの機能をリモートコントロールすることもで
きます。以下の表は、USB キーボードのショートカットのリストです。 
 
 

USB Keyboard ショートカット 
 
USB キーボードが接続される時、つぎのキー・コンビネーションまたはショートカットが有効です。 
 

キー操作 詳細 

F1 か Menu キー メイン Menu へアクセス 

F12 Home 

Ctrl + R Record 

Ctrl + S Stop 

スペースキー Play 

左カーソルキー メイン画面：リワインド、後ろの Q ポイントにジャンプ 

Menu と Ch 画面：ページの切替 

右カーソルキー メイン画面：ファストフォワード、前の Q ポイントにジャンプ 

Menu と Ch 画面：ページの切替 

上下カーソルキー メイン画面：ヘッドフォン音量調整 

Menu 内：エンコーダ回転操作に準じる。（スクロールリストなど） 

パラメター編集中：値の変更 

Enter キー Menu 内：現在の選択を有効に（エンコーダ押しに準じる）。バーチ

ャルキーボードの有効時に OK の選択と同じ。 

Q Menu 内：画面の４つのボタンの左上を選択。 

W Menu 内：画面の４つのボタンの右上を選択。 

A Menu 内：画面の４つのボタンの左下を選択。 

S Menu 内：画面の４つのボタンの右下を選択。 

1-9, 0 1-10 の Ch 画面 
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Copying to a USB Drive 
 
MixPre-10M は、USB A ポートに装着された USB サムドライブに SD カード上のアクティブなプロジ
ェクトを自動的にコピーすることができます。 この便利な機能により、クライエントにコピーデータ
を渡したり、バックアップ目的に利用できます。 USB サムドライブを挿すだけで、あとは MixPre-10M
が処理を行います。 
 
USB サムドライブが接続されると、SD カード録音された現在のプロジェクトのミラーを自動的に作成
します。 前に録音されたファイルのメタデータを編集しても、USB サムドライブに自動的にアップデ
ートされます。 
 
自動コピーは、再生や次の新しい録音開始に影響されることなく、ファイル録音が終了するとコピーを
開始します。これはタイムラグを減らします。その日の収録作業が終わる時、最後の録音ファイルが SD
カードへの保存完了を待つだけです。 
 
また、Project Copy 機能を使うことで、前のプロジェクトを手動でコピーすることもできます。 
 

Info: USB サムドライブの動作の信頼性のために Sound Devices の認証メディア(Approved 
Media) の使用を強く推奨します。Approved Media List は web ページから参照くださ
い。www.sounddevices.com/support/approved-media 

 
 
USB サムドライブへ project を auto-copy するには： 
 
 レコーダーの USB A ポートに USB サムドライブを挿入します。 

SD カードに録音されると自動的にコピー作業が発生します。 
 
 
copy の進行中を確認するには： 
 
 USB ドライブのステータスが表示されるまで、ステータス・バーをタップします。 
 
 
 

Info: copy 進行中に USB ドライブをレコーダーから抜かないでください。 
 
auto-copy 中、電源が失われたり USB サムドライブが誤って抜かれたりしても、コピーされたファイ
ルを修復することができます。 単純に、ドライブを挿し直したあとに録音してください。 
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User Presets and System Settings 
 
 
 

Saving and Recalling Presets 
 
フレキシビリティが MixPre-10M の特徴です。さまざまなシチュエーションでレコーダーを簡単に使う
ために、MixPre-10M の全てのセッティングをストアしたりリコールしたりできるよう設計されていま
す。セッティングを登録するためのプリセット・スロットが本体内部に４つあります。また、SD カー
ドにプリセットをストアする場合は、プリセット数にほぼ制限がありません。 
 
 
プリセットを保存するには： 
 
1.    をタップします。 

 
2. Presets をタップし、Internal 1-4 か SD カードに保存します。 

 
3. 任意のプリセットネームを入れて、OK をタップします。 
 
 
 
プリセットを保存するには： 
 
1.    をタップします。 

 
2. Preset > Load Preset とタップします。 

 
3. エンコーダを回して任意のプリセットを選択します。 

 
4. OK をタップします。 
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System Settings 
 
システム設定にアクセスするには： 
 
1.    をタップします。 

 
2. System をタップします。 

 
 

ページ サブメニュー 詳細 

1 File Transfer MixPre とホストコンピュータ間のファイル転送。 

1 Tone トーン信号の On/Off。 （レベルを -20dBFS から 0dBFS まで 1dB ス

テップで設定可。モードを Continuous か L-Intent に設定可。） 

1 Limiters リミッター機能の On/Off。 

1 Brightness タッチ画面とリング LED の輝度をそれぞれ設定。 

2 Date/Time 日付、時刻、表示形式の設定。 

2 Regulatory MixPre-10M に関する FCC コンプライアンス情報。 

(FCC ID: 2AKLX-739M10T and IC: 22225-739M10T) 

2 Version ファームウェアバージョン番号とシリアル番号。 

2 Update Firmware SD カード上のファイルから MixPre のファームウェアをアップデート。

最新のバージョンはウェブページからダウンロードできます。 

www.sounddevices.com/support/downloads 

 

 
 
 
 
 

http://www.sounddevices.com/support/downloads
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Remote Control 
 
 
 
 

Wingman Application 
 
Sound Devices Wingman は、- Google Play と App Store からダウンロードできる – フリーapp
で、Android か iOS 端末から MixPre シリーズの Bluetooth Smart のリモートコントロールを行うも
のです。 
 
MixPre レコーダーで Bluetooth を有効にするには： 
 
 
1.    をタップします。 

 
2. System > Bluetooth とタップします。これにより Bluetooth 機能を On/Off できます。 

 
 

Info: もしレコーダー上でリモートパスワードが設定されていると、Wingman は接続開始前
にパスワードの入力を求めます。 
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Wingman のタッチ画面インターフェースは、３つのメインエリアで簡単操作とモニタリングを提供し
ます。 
 
 ステータス - デバイスの詳細な情報を表示。 
 ビューエリア –トランスコントロール・ボタン、メタデータフィールド、レベルメータのあるト

ランスポート・ビューといった異なるスクリーン・ビューの表示。 
縦にスワイピングして他のメーターにトグル切替。 
小型の iOS デバイスで Wingmann app を利用するとき、水平にスワイピングして、トランスポー
トとトラック・ビュー間の切替。 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Tab バー - タブはどの画面でも常に表示されていて４つのアイコンがあります。 File List といっ

た他のビューにアクセスするためにタブを利用します。 
 

Info: 小型モバイルデバイスでは、カスタムネームとトラックアームはTrackビューで操作で
き、大型モバイルデバイスでは Transport ビューで操作できます。 

 
 



 

   

 

 

  59 

 

 
 

Connecting to a MixPre Recorder 
 
もし、Wingmanを利用できるSound Devicesデバイスが複数ある場合、Wingmanは通信範囲にある
有効なデバイスがすべて表示します。Connection アイコンをタップして接続先のデバイスを app から
切り替えることができます。 
 

Info: 同じ型番のレコーダーを複数利用する作業では、丸で囲まれた i マークをタップすると
該当のレコーダー画面に”Identifying from Wingman”メッセージが表示されるので、
正しいデバイスを認識するのに役立ちます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Wingman が動作中、画面に Sound Devices ロゴのアイコンの色で接続状況が示されます。 
 

カラー アイコン ステータス 

グレイ 

 

 

 切断中 – デバイスの不在、またはデバイススキャニング中。 

オレンジ 

 

 

 Bluetooth 接続途中。 

イエロー 

 

 

 接続中 - 認証途中。 

グリーン 

 

 

 接続中 – 認証完了。 

 
 
 

Music Projects via Wingman 
 
Wingman アプリの ver3.20 以降で、M モデルの MixPre シリーズ、Musician Plugin がアクチベート
さ MixPre モデルとの Bluetooth 通信をサポートします。 
 
MixPre と接続すると、MixPre シリーズ上で開かれているプロジェクト、接続されているモデルに応じ
て、Wingman のユーザーインターフェースが変わります。 
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Info: モデルやプロジェクトに関係なく、大画面のモバイルデバイスではトランスポート・
ビューで、小画面のモバイルデバイスではトラック・ビューで、カスタムネームとト
ラックアームを設定できます。 

 
 
トラックネームを編集するには： 
 
1. 次のいずれかを操作します。 
 

 大画面モバイルデバイスで、トランスポート・ビューから、編集したいトラックのメーターの
どこかをタッチします。 

 小画面モバイルデバイスで、トラック・ビューから、編集したいトラックのメーターのどこか
をタッチします。 

 
2. 画面のバーチャル・キーボードを使ってトラックネームを編集します。 
3. Done をタップして変更を確定します。 
 

Info: キーボード以外の他の場所をタップすると、編集をキャンセルできます。 
 
 
トラックをアーム／アーム解除するには： 
 
 メーターラベルをタップします。 アームされると赤色に変わります。 チャンネルが On でアーム

が解除されるとラベルは灰色です。 チャンネルが Off だとラベルは黒色でアーム設定できません。 
Music project でチャンネルが On でアーム解除されている時、再生中かオーバーダビング中のラ
ベルは緑色です。 

 
Info: チャンネルがリンクされている時、隣り合うメーターラベルが合体して、１つのラベ

ルとして表示されます。 
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USB Controllers 
 
 
 
Ver 3.00 以上の firmware から、MixPre シリーズ（M モデルを含む）にサードパーティ製のハードウ
ェア・コントローラを接続して快適なミキシング、レコーディング環境で作業することができます。 
 
楽曲制作、ポットキャスト、映像用のオーディオ録音に限らず、あらゆるアプリケーションにおいて、
フロントパネルのノブや Bluetooth 通信によるモバイルデバイスからのリモート操作に加えて、ハー
ドウェア・コントローラを追加することでより一層 MixPre の操作性が向上します。 
 
MixPre シリーズは、次の USB コントローラから操作することができます。 
 Korg NanoKontrol Studio 
 Korg NanoKontrol 2 
 Novation LaunchControl XL 
 Akai MidiMix 
 
これらのコントロール・サーフェースは、フィジカル・スライダー、ポット、ボタンなどで、フェー
ダーレベル、トリムゲイン、パン、リバーブセンド、ソロ、ミュート、REC アーミング、トランスポ
ート・コントロールを操作することができます。 
 

Info: すべての機能がすべてのコントローラでサポートされているわけではありません。 
 
 
 

Connecting the MixPre to a Controller 
 
MixPre と USB コントローラの接続性を簡便化するため、1 本の USB ケーブルにより通信と電源供給
が行われます。 接続されたコントローラの互換性を確実にするため、MixPre は接続されたコントロー
ラに合わせて自動的に構成されます。 
 

Info: MixPre-3と-6は、電源供給が不足すると省電力モードに入り、USBポートが使用でき
なくなります。 

 
コントローラを接続するには： 
 
1. MixPre の USB-A ポートに USB ケーブルの一端を挿入します。 もう一端は使用する機器に合わせ

た USB-B, Micro USB, Mini USB のプラグとなります。 
 
コントローラに付属した USB ケーブルを使用することをお勧めします。 

 
Info: MixPre の電源が入った状態でコントローラを接続しても問題ありません。 

 
2. MixPre は接続されたコントローラに合わせて自動的に構成を開始します。短い時間ですが、画面

には接続されたコントローラの名称がポップアップします。 数秒後、ポップアップ画面が消えた
らコントローラーは使用可能です。 

 
Info: MixPre に接続されると、一部の機能がコントローラ側に移行するため、その機能は

MixPre 上で操作できなくなります。 コントローラのモデルによりますが、fader, 
trim, pan, reverb send, low cut filter などの機能が移行します。 
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Map User-Definable Buttons to Shortcuts 
 
コントローラ上のボタンやノブの役割を MixPre 上の特定の機能にカスタマイズすることができます。 
アサインできる機能は以下です。 
 
 Tone 
 L/R Mute 
 X1/X2 Mute 
 Undo (Audio project のみ) 
 Slate Mic (MixPre-10T の Audio Project のみ) 
 Metronome (Music project のみ) 
 Add Q (Cue ポイント追加) 
 Record 
 Stop 
 Play 
 Rewind 
 Fast Fwd 
 Shuttole (すべてのコントローラに対応していません) 
 
 
コントローラのボタンに機能を割り当てるには： 
 
1. コントローラを接続します。 
2. MixPre の画面で、Menu > *Shortcuts > Control Surface にアクセスします。 
3. お好みの機能を設定可能なボタンに割り当てます。 
 
 
 

Controller Interface 
 
それぞれ、サードパーティ製コントローラによって使い勝手が違います。 次のセクションで、各コン
トローラの詳細について説明します。 
 

Info: MixPre-M シリーズは、Audio project をサポートしません。 
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Akai MidiMix インターフェース 
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Korg NanoKontrol 2 インターフェース 
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Korg NanoKontrol Studio インターフェース 
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Novation LaunchControl XL インターフェース 
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Specifications 
 
 
 

Audio Inputs 
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Audio Outputs 
 
 
 
 
 
 
 
 
 
 
 
 

Recorder 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

USB 
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Touch Screen 
 
 
 
 
 
 
 

Remote Control 
 
 
 
 
 
 

Power 
 
 
 
 
 
 
 
 
 

Environmental 
 
 
 
 
 
 
 

Dimensions and Weight 
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Software License 
 
 
End-user license agreement for Sound Devices MixPre Series Software / Embedded Firmware 
 
Important Read carefully:  
This Sound Devices, LLC end-user license agreement (“EULA”) is a legal agreement between 
you (either an individual or a single entity) and Sound Devices, LLC for the Sound Devices, LLC 
software product identified above, which includes computer software, embedded firmware, and 
may include associated media, printed materials, and “online” or electronic documentation 
(“SOFTWARE PRODUCT”). By using, installing, or copying the SOFTWARE PRODUCT, you agree 
to be bound by the terms of this EULA. If you do not agree to the terms of this EULA, do not use 
or install the SOFTWARE PRODUCT. 
 
 
Software Product License  
The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, 
as well as other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, 
not sold.  
Grant of license. This EULA grants you the following limited, non-exclusive rights:  In  
consideration  of payment of the licensee fee, Sound Devices, LLC, as licensor, grants to you, 
the licensee, a non-exclusive right to use this copy of a Sound Devices, LLC software program 
(hereinafter the “SOFTWARE”) on a single product and/or computer. All rights not expressly 
granted to licensee are reserved to Sound Devices, LLC. Software ownership. As the licensee, 
you own the hardware on which the SOFTWARE is recorded or fixed. Sound Devices, LLC shall 
retain full and complete title to the SOFTWARE and all subsequent copies of the SOFTWARE, 
regardless of the media or form on or in which the original copies may exist. The license is not 
a sale of the original SOFTWARE. 
 
 
Copyright 
All rights, title, and copyrights in and to the SOFTWARE PRODUCT (including, but not limited to, 
any images, photographs, animations, video, audio, music, text, and “applets” incorporated into 
the SOFTWARE PRODUCT) and any copies of the SOFTWARE PRODUCT are owned by Sound 
Devices, LLC or its suppliers. The SOFTWARE PRODUCT is protected by copyright laws and 
international treaty provisions. Therefore, you must treat the SOFTWARE PRODUCT like any 
other copyrighted material, except that you may make copies as only provided below. You may 
not copy the printed materials accompanying the SOFTWARE PRODUCT. Restrictions on use. 
Licensee may not distribute copies of the SOFTWARE or accompanying materials to others. 
Licensee may not modify, adapt, translate, reverse engineer, decompile, disassemble, or create 
derivative works based on the SOFTWARE or its accompanying printed or written materials. 
Transfer restrictions. Licensee shall not assign, rent, lease, sell, sublicense, or otherwise 
transfer the SOFTWARE to another party without prior written consent of Sound Devices, LLC. 
Any party authorized by Sound Devices, LLC to receive the SOFTWARE must agree to be bound 
by the terms and conditions of this agreement. 
 
 
Termination 
Without prejudice to any other rights, Sound Devices, LLC may terminate this EULA if you fail to 
comply with the terms and conditions of this EULA. In such event, you must destroy all copies 
of the SOFTWARE PRODUCT and all of its component parts. 
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Limited Warranty  
No warranties. Sound Devices, LLC expressly disclaims any warranty for the SOFTWARE 
PRODUCT. The SOFTWARE PRODUCT and any related documentation is provided “as is” without 
warranty or condition of any kind, either express or implied, including, without limitation, the 
implied warranties and conditions of merchantability, fitness for a particular purpose, or 
non-infringement. The entire risk arising out of use or performance of the SOFTWARE PRODUCT 
remains with you. No liability for damages. In no event shall Sound Devices, LLC or its suppliers 
be liable for any damages whatsoever (including, without limitation, damages for loss of 
business profits, business interruption, loss of business information, or any other pecuniary 
loss) arising out of the use of or inability to use this Sound Devices, LLC product, even if Sound 
Devices, LLC has been advised of the possibility of such damages. In any case, Sound Devices, 
LLC’s entire liability under any provision of this evaluation license shall be limited to the greater 
of the amount actually paid by you for the SOFTWARE PRODUCT or U.S. $5.00. Because some 
states/jurisdictions do not allow the exclusion or limitation of liability for consequential or 
incidental damages, the above limitation may not apply to you. 
 
Governing Law  
This agreement and limited warranty are governed by the laws of the state of Wisconsin. 
 
 
 
 
 
This device complies with part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause undesired operation. FCC Part 
15.19 (a) (3)  
 
Changes or modifications not expressly approved by the party responsible for compliance could 
void the user’s authority to operate the equipment. 
 
FCC Interference Statement 
 
This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses and 
can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does 
cause harmful interference to radio or television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to correct the interference by one or 
more of the following measures: 
 
 Reorient or relocate the receiving antenna. 
 Increase the separation between the equipment and receiver. 
 Connect the equipment into an outlet on a circuit different from that to which the receiver 

is connected. 
 Consult the dealer or an experienced radio/TV technician for help. 
 
This device complies with FCC and ISED RF Exposure SAR limits exposure limits for general 
population / uncontrolled exposure. 
 
This Device complies with Industry Canada License-exempt RSS standard(s). Operation is 
subject to the following two conditions: 1) this device may not cause interference, and 2) this 
device must accept any interference, including interference that may cause undesired operation 
of the device. 
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